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Welcome From The Chief Editor
Back before the kids came along, Laura and I would go on LONG bicycle rides, frequently riding 30 to 50 miles (~48 to 80.5 Km) at a time. Once the kids came along, coupled with demanding work schedules, bicycle rides became something we only did every once in a while. Oftentimes, there were long gaps between bicycle rides.
But now that the kids are older, and since I've started cutting back on the hours that I work, those opportunities for bicycle rides are (happily and thankfully) coming along more frequently now. We like to ride on the multi-use trails, particularly those in Iowa. We are drawn to the trails in Iowa. They are old, converted rail lines, which means going through countryside in areas many don't get to see if you stick to the roads.

Riding on the Raccoon River Valley Trail, in Adel, Iowa.
Specifically, our favorite trail is the High Trestle Trail, which goes 25 miles from Woodward, IA to Arkeny, IA. It's just north and west of Des Moines, and the entire trail is paved in either concrete or asphalt. We load the bicycles into the truck and make the three hour drive to the trailhead in Woodward, IA. In fact, it's a popular destination with the kids. They LOVE that bike ride. When we tried to check out a different Iowa trail (the Raccoon River Valley Trail) in Adel, IA, both of the kids let us know how much they "miss the bridge."
The namesake attraction on the High Trestle Trail is ... of course ... the "high trestle." From where we get on the trail in Woodward, the trestle bridge is 2.6 miles (4.2 Km) east. The bridge is one-half mile (~0.8 Km) long and 13 stories high, going over the Des Moines River. The vistas from the bridge are spectacular. You can see for miles all around.
Ryan has been able to ride without training wheels for over three years now. Lexi just learned to ride without training wheels. After some extended time of not being ridden for a while, we had some minor tune ups to do to our bicycles. My road bike, a Raleigh Revenio 2 that I purchased in 2012 (and pictured above), fared the worst. The shifter cables that came on the bicycle from the factory were coated in a plastic that is derived from vegetable oil. That probably would have been alright, if I had somewhere to store my bikes, like in a garage. But, since I don't have a garage, my bikes are locked up on my covered front porch. It keeps most of the weather off of them, but doesn't keep the critters away. And, as you would know it, the squirrels found my bike's shifter cables ... and thought they were a buffet. They gnawed on the cables, hastening the deterioration of the shifter cable plastic coating. Plus, their sharp little teeth caused the metal cable inside of the cable housing to start to fray. Yep. They bit right through some of the metal strands that make up the cable.
So, I had to take my bike to one of my favorite local bike shops to have the shifters recabled. I typically do the vast majority of my own bike repairs, but the shifters on my road bike are nothing like the shifters on road bikes from 50 years ago (I have a "classic" road bike that I've rebuilt, a 1973 Nishiki). The shifters on the Raleigh are built into the brake levers, and I had no idea of the finer points of how to adjust them. So, I figured it was a task best left to those who deal with them all of the time.
While there on a subsequent visit to buy new handlebar tape, we happened to mention that we were trying to get Lexi to ride her bike without training wheels. We had already removed one of the training wheels. The bike shop guy, who I've known for quite a while, gave us a tip on how to get rid of the training wheels quickly. Take off the training wheels AND the pedals. It effectively turns the bike into a strider bike, forcing them to focus on mastering the balance part of riding a bike. Then, once the balance is mastered, put the pedals back on. He assured us it would take less than a week.
He wasn't kidding. When I got back home, I took the pedals off of the smaller bike. Within two days, she had the balance part of riding a bike mastered. On day three, dad put the pedals back on the bike. She took off on it, pedaling away as if she had ridden a bike for all of her life.
Of course, when we go on bike rides, we don't do the 30 to 50 mile distances we used to ride. The longest the kids have ridden is 11.5 miles (18.5 Km) ... and that was while Lexi was still using training wheels. I'd say that's pretty good, especially for an eight and five year old! We usually ride around eight miles (12.9 Km) when we go on bike rides, depending on how hot it is. The hotter it is, the shorter our rides tend to be.
Still, it feels great to be back out there riding the bikes again, and even better to be able to share it with my kids. It's a fun activity that our whole family enjoys!
********************
This month's cover by Meemaw commemorates International Literacy Day on September 8, 2021.
********************
Until next month, I bid you peace, happiness, serenity, prosperity ... and good health. Please, stay safe ... and get vaccinated!


Want To Get Started In Photography On A Budget?
by The_CrankyZombie & Paul Arnote
In the PCLinuxOS forum, hakerdefo posted a good question to our resident cook, HTML and Ebook creator, webmaster, networking guru, and photographer, The_CrankyZombie. Here it is in its entirety:
So if someone who is permanently broke (financially) and totally new to photography and wants to buy a camera to learn photography, what would be your recommendation?
Hakerdefo's question, coupled with The_CrankyZombie's reply, gave birth to this article. Anyone who has spent much time in the forum will recognize the hundreds of photos that The_CrankyZombie has posted and shared with the PCLinuxOS forum members.
Here is The_CrankyZombie's well thought out reply to hakerdefo:
Buy the best camera you can afford, even if that means buying a used camera. Don't buy a lens just because it is cheap. Most of the time, you will just be wasting your time and money with it. Good glass costs money for a reason. Learn the limits of what your lens will do. Prime lenses usually perform better than zoom lenses of the same length, but they may also cost more. Before you buy an expensive telephoto lens, try renting one first and see if it does the job you need. In the long run, it will save you money. Learn your camera inside and out, and don't rely on the "A" (automatic) setting. Learn the P, T/S, A or M mode or on some cameras like Canon. The P, AV, TV, M modes are called the creative modes, and each one gives you a bit of different control over the camera, with the M (manual) mode being fully manual. Don't be afraid to experiment with them.
A tripod/monopod is your friend, so make good use of your friend. Beside anything else, practice, practice, practice taking photographs. Don't just take a picture. If you don't understand something about your camera or photography, ask. The only dumb question is the one no one asks. Join a photography club if there is one near you. Learn from other peoples experience, because they are a wealth of knowledge. Most of all, take your camera everywhere you go. You never know when you will get that "Oh, My God" photo.
As for which model of camera is the best, I'm sorry that I can not tell you. While cell phones, point and shoot and bridge cameras all can take some great photographs, the dSLR and the ILC (interchangeable lens) cameras still rule the roost, and for good reasons. As for which one works for me, that is pretty simple to answer. It is the one that is in my hand. It is the person that is taking the photograph, not the camera. For me, I prefer a Canon dSLR. I also have a mix of lenses from consumer grade to professional Canon "L" lenses. They also date back to yesteryear of the film era 60's &70's (fully manual) to the modern that are fully automatic with image stabilization. Just remember that the lens is far more important to a good quality image than that of the camera itself. While it is true good equipment helps, the equipment does nothing without the person holding it and seeing the world through the lens. Don't expect that you are going to take perfect photos every time. That just will set you up for disappointment. Just ask me how I know that.
Perhaps some of the other users here will chime in on their ideas. I know parnote and tuxlink have a lot of experience. If you have questions, by all means, please do ask.
Paul's Photography Journey
As for myself, I was a professional newspaper photographer in my "former life" (before I left the field and started a second career as a respiratory therapist). I studied journalism when I was a student at the University of Kansas. I've worked as a "stinger" (freelancer) for the Associated Press, United Press International, the Kansas City Star, and the (now defunct) Kansas City Times, and as a staff photographer for the Independence (MO) and Blue Springs (MO) Examiner. I've won awards for my photos from press associations, and I've had my pictures appear in newspapers all over the world.
My interest in photography began when I was 12 years old. As a kid in the 1970s, I didn't have a lot of money, but that didn't deter or dampen my desire to learn about photography. Armed with the 35mm point-and-shoot camera that I had worked and worked to save up for by mowing lawns, saving my allowance, birthday money and any other source I could wrangle, I went to the local public library and read EVERY. SINGLE. PHOTOGRAPHY. BOOK. that I could get my hands on. Back then, the library had a complete set of the Time-Life books to learn photography from. I read every one of them, cover to cover, multiple times.

Fairly representative of my first 35mm camera
It wasn't long before I was looking around and thinking of what I saw in terms of shutter speeds, apertures, depth of field, ASA/DIN, composition, and all of the other things that photographers of that time were ruled by. Rather quickly, I outgrew the capabilities of the inexpensive point-and-shoot camera that was my first camera. I needed something that didn't do everything for me, exposure-wise, anyway. By that time, I was working part-time at the local drive-in theater on the daytime cleanup crew. It was time to start saving again, this time with me saving my weekly paychecks from the drive-in theater. I needed a SLR camera.

Sometime around 1975, I found a brand new Vivitar 220/SL camera from a mail-order photo store in New York city, complete with a Vivitar 50mm f 1.8 lens. It had a built in center-weighted light meter, a self timer, and accepted universal 42mm Pentax screw-mount (M42) lenses. The photo above is from eBay, and its current price there is/was $50. I paid $148 for the camera when I bought it, including shipping and handling and C.O.D. fees (remember those?). Over time, I added a Focal (K-Mart brand) 135mm f 2.8 telephoto lens, a generic 28mm f 2.8 wide angle lens, and a Spiratone 400mm f 6.3 manual aperture lens.
As a teen with very limited funds in the 1970s, I came to LOVE the old Spiratone photography store. They had ads in the back of ALL the photography magazines of the time. One thing they sold -- and they sold a LOT of these -- were very cheap manual aperture lenses. Yes, it's a real PAIN to use a lens with a manual aperture. You have to remember to close the aperture before you shoot your picture. But, at the time, it was the only option that I could afford. I'm not sure if these types of lenses even exist today (but you can buy them used on eBay all day long).
Around this time, I "inherited" my dad's old 120 format twin lens reflex camera. The reflex mirror was in poor shape, so I remember carefully taking it apart (myself) and successfully replacing the failing/peeling/mottled mirror. That was a fun camera to shoot. Also, one of my journalism instructors in high school gave me an old Argus C3 35mm rangefinder camera, circa 1940s. That was also another fun camera to shoot, and one I shot more frequently, since I also developed my own film and printed my own pictures by that point in time.

When I got to college, I realized that my old equipment wasn't going to allow me to grow my photography skills the way I needed it to. So, I sold my old equipment to my cousin, and bought an Olympus OM-1 MD. I soon thereafter bought myself the motor drive for the camera, a 28mm f2.8 lens, and a 135mm f2.8 lens. I used this combination for a couple of years, with good results.

At that particular time in the late 1970s, the "popular" brands of 35mm SLR cameras were Nikon, Canon and Minolta, with the first two used almost exclusively by all the professional photographers I crossed paths with. Nikon was the higher priced of the two, so I again switched camera systems, going with Canon. Plus, the Canon A-1 was all the rage, having just come out. I sold my Olympus camera and purchased two Canon A-1 cameras, both with high speed motor drives. I found an older used Canon 35mm f2.0 lens, and purchased a brand new 100mm f2.8 lens. That's what I started with for the Canon. I later added a 24mm f2.8 wide angle lens, a 200mm f2.8 telephoto lens, a 300mm f4.0 telephoto lens, a used 400mm f4.5 telephoto lens, and later a 300mm f2.8 telephoto lens. All of the lenses I bought were Canon branded lenses.

I later added two of the new Canon F-1 cameras, also with high speed motor drives. They joined my two A-1 cameras, but became my main cameras up until I left the field. It is with the Canon equipment that I won awards. I still have much of my Canon professional equipment, although I do admit to selling off one F-1 camera body, as well as the 400mm f4.5 and 300mm f2.8 lenses.
So, I went from a 12 year old spending his lawn mowing and birthday money on his first camera, to a working professional photographer, in steps. I did not go out and buy the most expensive professional grade equipment at the outset. I worked my way up to it.
After switching professions, I didn't really seriously touch a camera for another 12 or more years. When I quit working as a professional newspaper photographer, I really didn't realize just how "burned out" I was. I just needed to let photography "rest" in the background for a while.


Digital photography was barely a newborn in the late 1980s, when I left the profession. When me and my colleagues at the newspaper saw the results of the "new" digital cameras with its blurry, pixelized, postage-stamp sized images, and upon hearing that "digital cameras were the future of photography," we scoffed and laughed. Its images rivaled a Rorschach test in clarity. I distinctly remember the discussion going somewhere in the direction of, "We have nothing to fear. Film will ALWAYS rule the photography world!" How little did we know how rapidly digital camera technology would advance, and how quickly digital would replace film as being the mainstay of photography that we now know it to be today.
What rekindled the photo bug in me was the emergence of digital photography that was approaching the quality of film. It married photography, at least in my mind, with my other passion of computers. Starting with the Sony Mavica FD73 (640 x 480 images and a 10x optical zoom) that stored images on a floppy drive, I've had a number of digital cameras over the years. I currently have (amongst the many digital cameras I own) a Canon SL1 dSLR with a small, overlapping assortment of zoom lenses. I've also purchased an adapter that allows me to use my manual focus Canon FD lenses with my SL1. In between the FD73 and the SL1, I have the Sony Mavica that stores images on miniature CD-R discs, a couple of point-and-shoot digital cameras (one of which resides in my hunting backpack for those hunting trophy shots), a Fujifilm bridge camera, and a Canon bridge camera. Taking pictures of the kids keeps that interest in photography burning.
The_CrankyZombie's Photography Journey
I dipped my toes into photography when my Grandfather gave me a Yashica A TLR (Twin Lens Reflex) Camera for my 15th Birthday. It wasn't new, as he had bought it in 1959 for a whopping $35.00, but now it was mine. I remember the first roll of 12 exposure 120 film I shot with it, and the waiting to have it developed.

Yashica A - TLR (Twin Lens Reflex) - No batteries required!
I used it until I went into the Army in 1972. After basic training, I went so far west I ended up in the Far East, Okinawa, Japan to be exact. Back then the dollar was worth 3 times more in Yen than it is today. A pineapple from the fields in Northern Okinawa would set you back 100 yen or about 33 cents. Ah, life was good and consumer goods were cheap. In 1973, I bought my first SLR Camera, a Yashica TL Electro X, with a Yashinon DS-M 50mm 1:1.7 lens and a 80-200mm telephoto lens. It cost me several months of pay. I used this camera into the mid 1990's. I do still use both my Yashica A TLR and my TL Electro X occasionally. But the cost of film and developing is expensive. I just sent off a roll of 120 12 exposure film to be developed and scanned. It cost $31.25 to get back the developed film negatives, a disk of scanned images and a new roll of 120 color 12 exposure film. Only you can judge if shooting film is right for you.

Taken with the Yashica A - TLR Camera

Yashica TL Electro X with Yashicon DS-M 50mm M42 screw mount lens
My first digital camera was the Kodak DC50 (1996) . It was a whopping 0.38 megapixel CCD sensor, and took a picture at 756x508 resolution, with a 1 megabyte internal memory which would store 6 images. It could also use a PCMCIA card, which could store 26 images. It only stored images in Kodak's proprietary KDC file format. At the time the DC50 came out, it was the first digital camera to cost under $1,000 to support PC Cards (PCMCIA) type I and II.

Kodak DC50 0.38MP
In the early 2000's, I bought a FujiFilm S3200 Bridge Camera. A 14 MP Digital Camera with a Fujinon 24X Super Wide angle Optical Zoom Lens (24mm-576mm) While it was a nice camera in my ways, it just wasn't as sharp as it should have been on the longer end. The camera was just missing something I wanted and needed. I put up with the shortcomings, until 2015-2016 when I was talking to a friend, and he offered to sell me a spare camera he had.

Fujifilm S3200 14MP Super Zoom Bridge Camera 24mm - 576mm
This has the same size sensor found in a Samsung Galaxy Camera 1/2.3-inch sensor
Soon, I was the owner of a Canon XTI, a 10MP dSLR. I bought a couple of lenses for it. What I had felt was lacking in the Fujifilm camera, I found in the Canon. I suddenly found the sharpness and clarity that had been missing.


Canon Rebel XTI 10.5MP APS-C dSLR
I used the Canon XTI until I bought my Canon SL2 24mp dSLR in January 2019.

Canon Rebel 24.2MP SL2 APS-C dSLR
In 2020 I bought my first MILC Camera (Mirrorless Interchangeable Lens Camera) the Canon M50 24mp. It was very similar to the SL2 dSLR, with the biggest exception of not having a mirror, and using a newer EOS-M lens mount. You can use the EF and EF-S lenses from current to the ones made back in 1986 with the proper EF to EOS-M adapter. The M50 does have some features that the SL2 doesn't have, like the latest digi 8 processor, an electronic viewfinder, and has 4K video, while the SL2 has only 1080p. However, the battery life sucks on the M50. It is power hungry. If you are into shooting videos or vlogging, a M50 is the better way to go. As for the camera size and weight, the SL2 and the M50 are close to a tie. I chose to sell the M50 and kept the SL2.

Canon M50 24.1MP APS-C MILC (Mirrorless Interchangeable Lens Camera)
I just recently bought my first full frame camera, a Canon 5D with a 50mm lens, for under $100.00. It is a used camera, but that doesn't really matter. However, the fact that it is a full frame camera and they are built "battleship rugged" still matters. It can use all the same lens that I use on my Canon SL2. I have over 20 lenses I can choose from in my collection, from vintage lenses to Canon's "L" series professional lens. You can use most any lens, except for those made for a APS-C camera (EF-S) or the MILC lenses (EF-M/EF-R). You can even use Canon's FD lenses and non EF mount lenses from other camera manufacturers, using a proper adapter.

Canon EOS 5D 12.8MP Full Frame Camera
Getting Started On A Budget
So now, you might be asking, "I don't have a lot of money, so how do I get started in photography?"
Fortunately, getting started in photography is much easier and much less expensive today than it was when I got started in 35mm photography. "Back in the day," you had to be able to afford film, and then pay to have that film processed. Today, the new normal is digital photography. You take a picture and you store it on a SD memory card, which can then be transferred to your computer. Once your images are on your computer, you can pick through your photos, edit them, and then select which ones you want to print out. Before, you had to pay to have prints made of every single image, whether it was exposed properly, out of focus, or some other malady that would strike. Now, you only print out the ones you want.
So, where do you find affordable used equipment?
One place to check is close to home, in the Craigslist Photo & Video category. Sort through the offerings, because you will find a LOT of vintage cameras and 35mm cameras. Just a quick perusal of what's for sale in my area around Kansas City, I found a Canon A1100 for only $15. I also found a Canon SX 500 IS 16MP digital camera for only $100. Both are quality digital cameras, even if they are not dSLR cameras. But hey ... you have to start somewhere, right? For not much more, I found a Sony A200 DSLR Camera with two lenses for only $120. If you don't find something right away, keep looking. The offerings on Craigslist change frequently, and you never quite know what you're going to find.
You can also look on eBay, but don't expect to find super bargains on there as easily. Most of the people selling on eBay KNOW what they have, and price it accordingly. That's not to say, though, that there aren't bargains lurking out there. They are just a lot harder to find.
Don't forget about checking out garage sales, carboot sales, thrift stores, and flea markets. You can find literal steals at these locations. Don't get in a hurry and keep in mind that on many days, you WILL come up empty. But, perseverance pays off in a huge way, with you walking away with some very high quality photography equipment for pennies on the dollar.
Of course, if you can afford it, new photography equipment is available that fits into many budgets. Do your research, and you might just walk away with a really great deal when stores are clearing out last year's models for the new, incoming models.
Whichever route you choose, take your time to really LEARN your camera, its capabilities, and its limitations. Knowing your "tool" is the first step in becoming a more accomplished photographer.
Conquer The Basics
Now that you have a camera, it's time to conquer the basics of photography. With so many factors to pay attention to when learning photography, it's easy to become overwhelmed and not really know exactly where to start. Having the equipment -- your tools -- is only a part of the journey. So, what follows are my suggestions, based on my experience.
Shutter speed is shutter speed, whether you're shooting film or digital images. Aperture is aperture. Depth of field is depth of field. Focal length is focal length. Exposure is exposure. ASA is ASA. The rules of composition don't change with the format (film or digital). Those basic concepts of photography have been in play since the time that the very first photographic image was made.
So, I suggest that you read, read, read. Then read some more. Conquer each concept before moving on to learn another concept. You will find that some concepts are interrelated, but don't let that deter you.
BUT, as you're reading, DON'T just keep reading without practicing what you are trying to learn about. Conquer ONE TOPIC AT A TIME. When you're reading about apertures, try your camera out at large and small apertures, and pay attention to the results you get. What's different? Which works out best, when? The same thing applies to all of the other aspects of photography's more technical side. When you're learning about shutter speeds, see what happens with a fast shutter speed versus a slow shutter speed. When you're learning about depth of field, see what happens with shallow depth of field, versus deep depth of field. Grasp each concept before you move on to learn about another!
Because it's the way I learned, I have a soft spot for the Time-Life photography books that I read in my local library. I would be surprised if they were no longer available in many libraries around the globe. Of course, there are many other photography books available in local libraries. I know. I read them ALL (at least the ones that my library had in their collection) many, many years ago.
Of course, with the explosion of the internet, photography students can also find many online resources to utilize in their photography education. That is a resource that wasn't available to me when I learned, and one that I think would have been helpful.
So, which concept should you start with first? I say learn the rules of composition. You can have the most perfect exposure, the most appropriate depth of field, etc., etc., but still produce a photo that leaves viewers going "meh," all because the image wasn't composed properly. Take the time to learn about the "Rule of Thirds" and how it applies to photo composition. Following this basic concept will make your images visually powerful, and will sometimes lead your viewer's eye to other important elements in the image. That doesn't mean that you sometimes can't center your subject in the frame, but do keep the concept in mind when you're shooting your photos. It can make a whole world of difference.
Summary
We only wanted to help get you started down the path of learning photography, and making better pictures. We don't/won't/can't provide all the photography education you want or need in the pages of this magazine. It's not our purpose, and there are better resources for that. There are also more online resources than we can even begin to list here. Just use your favorite search engine, and search for "beginning photography" or "learn photography" or something else of that sort. You will have absolutely NO trouble finding instructional sites on the internet.
We hope that we have at least given you some idea of exactly where to start on your journey to learn photography. Whatever happens, don't give up. It may be a long journey, but one that's worth it and one that will pay dividends that you can see in the quality of your images.













Short Topix: Google May Have Invented Time Crystals
by Paul Arnote (parnote)
DuckDuckGo Initiates HUGE Ad Campaign


All across the globe, internet users have noticed an explosion of billboards advertising the DuckDuckGo search engine. See the two pictures above as examples.
At a time when internet privacy is under increasing attack, DuckDuckGo (DDG) is making a push to get its name out in front of more and more users. Those who are already concerned about internet privacy already know about DDG and how it anonymizes search data so that none of your personal information is collected, and how it doesn't track you across your internet travels.
So, just how does DDG make money from its search engine? Easily enough, that answer can be found on a DDG Q&A web page, called "What Is the Business Model for DuckDuckGo?"
Here is an excerpt from that DDG web page:
DuckDuckGo has been a profitable company since 2014 without storing or sharing any personal information on people using our search engine. As we like to say, what you search on DuckDuckGo is private, even from us! We're proud to have a business model for a web-based business that's profitable without making your personal information the product. I'm happy to tell you all about how we make it work (and how other companies can, too).
Though first, if you're not familiar with DuckDuckGo, we are an Internet privacy company that empowers you to seamlessly take control of your personal information online, without any tradeoffs. We operate a search engine alternative to Google at https://duckduckgo.com, and offer additional apps and extensions to protect you from Google, Facebook and other trackers, no matter where you go on the Internet.
It's actually a big myth that search engines need to track your personal search history to make money or deliver quality search results. Almost all of the money search engines make (including Google) is based on the keywords you type in, without knowing anything about you, including your search history or the seemingly endless amounts of additional data points they have collected about registered and non-registered users alike.
In fact, search advertisers buy search ads by bidding on keywords, not people. It makes intuitive sense, too. If you search for 'car', you are more likely to respond to a car ad than something you searched for last week.
This keyword-based advertising is our primary business model. When you search on DuckDuckGo, we can show you an ad based on the keywords you type in. That's it. And it works. Our privacy policy, in a nutshell, is to not collect or share any personal information at all. Every time you search on DuckDuckGo it is as if you were there for the first time -- anonymous.
It makes sense. So, why does Google persist in tracking you with your personal data? One word: greed. Quite some time ago, Google's greed overran their popular -- and former -- motto, "Do no evil." You can read more about it by visiting the DDG web page.
I, for one, have changed to using DDG as my primary, "go to" search engine in all of my browsers that I use with any regularity. Admittedly, I haven't changed the default search engine to DDG in my browsers I don't use as often, but doing so is high on my list of "things to do" whenever I do use those browsers again.
I suspect that as more is revealed about Google, its privacy invasions, its tracking, and other dubious information about the company too plentiful to list here, more people will be changing their preferred search engine. It took me a while, but once I switched, I haven't looked back, and I certainly haven't had any regrets.
A Renewed Search For ET With A New Method

Illustrative photo of Galileo Galilei refracting through a telescope. (photo credit: THE GALILEO PROJECT)
According to an article in the Jerusalem Post, a Harvard astronomer is proposing a newer way to search for ET. Instead of looking for radio waves and other signs of intelligent life as SETI does, Israeli scientist Prof. Avi Loeb of Harvard University's Astronomy Department is proposing the use of cameras and smaller telescopes to search for garbage.
Loeb doesn't want to use warehouse-sized powerful telescopes. He asserts that their field of view is too narrow. Instead, he wants to use a network of smaller medium sized telescopes with a wide field of view, located in specific locations around the world, to scan for the "garbage" of intelligent civilizations. He claims that would be the "smoking gun" to verify that other extraterrestrial civilizations are, indeed, out there.
His project is called the "Galileo Project," and could start amassing data as soon as 2023.
In 2017, our solar system received its first interstellar visitor when the object dubbed Oumuamua (traveller in Hawaiian) cruised through our neighborhood. Scientists only really ever got to see much of Oumuamua as it was on its way out of our solar system, leaving many questions and much debate about it in its wake. Loeb contends that had his proposed system been in place when Oumuamua cruised by, many of the questions we have about it would have already been answered.
Want To Protect Your Smartphone From Hackers? It's Easier Than You May Think.

Who better than the master hackers themselves -- the NSA -- for information on how to best protect your mobile devices from hackers. And, it's only two steps.
Step One: Turn your mobile device off.
Step Two: Turn your mobile device back on.
Do this at least once a week, and you will go a long, long way to preventing hackers from gaining access to your data, according to an article from the Associated Press. While there isn't much that can be done to totally thwart the efforts of hackers to gain access to the information and data stored on your mobile device, simply turning your phone off, then back on will make them work much, much harder to access that goldmine of information.
If you make it harder for threat actors to access your information and data, there's a good chance they will move on to a much easier target who isn't as security minded.
The NSA released a guide on best practices to safeguard or protect mobile devices last year. You can download it for free from here (PDF).
The War On Your Privacy Monthly Update

THE NSA HAS WARNED ITS CONTRACTORS AND AFFILIATES TO AVOID using public wifi networks, as well as bluetooth and NFC connections in a public environment. Their guidelines represent a set of guidelines that represent "best use" practices. While aimed specifically at users who are involved in national security, members of the public would do well to also heed their advice. The NSA has published their recommendations/guidelines here (PDF), for all to see.
T-MOBILE WAS RECENTLY HACKED, and the private information of up to 100 million users was gathered and made available for sale. Information from 30 million users was offered up by a hacker on an "underground forum" for the equivalent of $270,000 in BitCoin. The remainder of the customer data is being offered up for sale through private channels, according to an article on Engadget.
THE NSA HAS AWARDED AMAZON A "SECRET" $10 BILLION CONTRACT to move some of its voluminous amounts of data to Amazon Web Services servers, according to an article on Nextgov. There are no reports of "privacy concerns," other than the fact that it involves the NSA, and that is NEVER a good combination any time you are talking about "privacy."
A NEW ANDROID THREAT THAT RESEARCHERS CALL "FLYTRAP" is responsible for hijacking the Facebook accounts of over 10,000 users in 144 countries, according to an article on BleepingComputer.com. It uses a JavaScript injection to steal information, as well as the session cookies for a user's Facebook session. The malware threat actors use social engineering tricks -- like offering discount coupons for popular sites like NetFlix -- to trick people into clicking on the ad for the discount. When they click on the ad for the discount, the malware then proceeds to steal the Facebook session cookie, along with some other potentially sensitive data.
Google May Have Invented Time Crystals

It's not very often we get to offer up praise for Google, so this feels a bit odd.
According to an article on TheNextWeb (and widely reported on throughout many media outlets), a team of dozens of scientists working in partnership with Google's quantum computing labs, MAY have created the world's first time crystals. In doing so, they MAY have created a whole new phase of matter.
I cannot EVEN BEGIN to explain the significance of time crystals and what they may mean. In fact, most of the rest of the world can't wrap their head around them, either. All I can tell you is that they can shift between different configurations, all without using or losing any energy. Go read the article on TheNextWeb by Tristan Greene. He makes an honest and valiant attempt to explain time crystals, especially when no one can really agree on the significance of such a discovery. I can tell you that this could ... maybe ... potentially ... possibly ... be responsible for more rapid growth of quantum computing.
If you want to wade neck-deep into the physics of time crystals, you can read Google's scientific paper about them here (PDF).
Material Can Convert Waste Heat To Electrical Energy

Have you heard of thermoelectric generators? Yeah, me neither. But, they are currently helping to power the Mars rovers by converting waste heat into electrical power. The problem is that the thermoelectric generators being used by the Mars rovers are quite expensive to manufacture.
Research scientists, however, have found a way to make them much cheaper, according to an article in Science magazine. So the researchers looked at tin selenide crystals, which proved to be too costly to manufacture. They then looked at combining tin and selenium powders that, once heated and compressed, makes tin selenide crystals cheaply.
Thermoelectric generators work by passing the heat from the hot side of the object through to the cool side, which sets up an electrical current. For example, if you put a thermoelectric generator on the exhaust manifold of a car, the side in contact with the exhaust manifold is the hot side, and the side farthest away from the exhaust manifold is considered the cool side. The movement of the otherwise wasted heat from the hot to the cold side sets up an electrical current, which can be used to power components, or that can charge a battery.
Say Hello To The Windows 11 Linux Look-Alike

Zorin OS, a Linux distribution, has created a version for power users and professionals that looks like the upcoming Windows 11. The Win11 "window dressing" is only available to users who use the paid Zorin OS Pro version of the operating system. Its release is expected within the next few months.
So, users can get the appearance of Windows 11, but the stability and security from running Linux. Zorin OS Pro comes with a full suite of productivity programs, such as GIMP, an Ebook reader, accounting software, 2D and 3D CAD software, a password manager, and much more.
Purchasers of Zorin OS Pro will also have access to Zorin OS Pro Lite, a special version of the OS that is designed to run fast and stable on older computers. Paid users will also get access to Zorin Installation Support services, as well as helping to support the future of Zorin OS.
Two Bicyclists Ride Their Own Tour de France, And Finish Ahead Of The Race Peloton

Lachlan Morton Photo: Rapha/Lucy Le Lievre

Jack "Ultra Jack" Thompson Photo: Tristan Cardew
I don't talk about one of my favorite activities, bicycling, very much. But the accomplishments of these two bicyclists is, in my opinion, just mind blowing.
First, on July 13, 2021, Bicycling magazine ran an article on Australian cyclist Lachlan Morton (top photo) riding his "Alt Tour" during the annual Tour de France bicycle race spectacular extraordinaire. Ok ... it's arguably the premiere bicycling race on the planet. Not only did Morton ride his "Alt Tour" completely self-supported without teammates, but also with no pursuit support vehicle, no soigneur, no chef, and no mechanic, AND he ALSO rode his bike from the end of one stage to the beginning of the next stage.
To better visualize Morton's feat, this year's Tour de France's 21 stages was 3,414 Km (2,121 miles) long. With riding from the end of one stage to the beginning of the next, Morton's "Alt Tour" took him 5,510 Km (3,423 miles) to accomplish. He also climbed 23,000 more meters (75,459 feet) than the Tour de France competitors. Morton also skipped the two rest days that the competitors get, and rode at night as he needed to.
Morton raised money with his "Alt Tour" to help donate 3,270 bikes to those in need.
Meanwhile, Jack "Ultra Jack" Thompson (bottom photo above), also from Australia, also rode by himself to complete the entire Tour de France stages, as reported in Bicycling magazine on August 13, 2021. The 2021 Tour de France went from June 28 to July 18, with two off-days scheduled there for the competitors. Thompson started his personal Tour de France on July 5. His goal was to catch up with the Tour, pass them, and then stay ahead of them. Riding two stages a day (which meant pedaling for 13-14 hours a day on some days), he passed the Tour competitors on their rest day in Andorra. Thompson finished his personal Tour two days ahead of the actual Tour de France peloton, making the requisite traditional eight laps around the Champs-Élysées.
Thompson differed from Morton in his approach, in that he had a support staff and a pursuit vehicle. After riding his two stages per day, he would often only get a few hours of sleep before it was time to start riding the next two stages.
Even though I love bicycling, I'm not sure that I could do more than ONE stage of the Tour de France. These guys did the entire Tour de France, in fewer days than the Tour competitors. In my humble opinion, that is simply amazing.
NASA Looking For Way To Kill ISS

NASA is looking at how to safely dispose of the International Space Station when the microgravity platform reaches the end of its lifespan, according to an article from United Press International. The United States started launching and assembling the space station in low earth orbit in 1998. The platform was projected to have a lifespan of 30 years.
Those 30 years are up in 2028. The current plan, although not set in stone and has been tentative since its inception, has been on the table since 2010. It involves Russia launching one of its Progress service modules, and using the thrusters of that service module to start a controlled reentry for the space station. The 450-ton space station should mostly burn up in Earth's atmosphere, with remnants of engines, laboratories and living quarters falling into the Pacific Ocean.
But, there's a possible snag in that plan. Russia has announced plans to withdraw from the ISS in 2024, and then possibly be completely done with it by 2025. That's well before 2028 when the space station's lifespan is finally up. So, NASA might not be able to rely on the use of Russia's Progress service module to fulfil the reentry plan as it's written right now.
NASA might be forced to come up with an alternate plan that doesn't rely on the use of Russia's Progress service module. While they are looking at possibly using a SpaceX Dragon vessel, or Japan's H2-A vessel, the most likely candidate is Northrop Grumman's Cygnus cargo module as a replacement for the Russian module.
PCLinuxOS Magazine Short Topix Roundup

SCIENTISTS HAVE FOUND A REMARKABLE LINK BETWEEN GUT HEALTH AND THE REVERSAL OF AGING, according to an article on Inverse. Researchers transplanted fecal matter from young mice into the GI tract of older mice. Afterwards, the older mice performed better on cognitive tests than they did previously. Upon dissection and studying their mouse brains, they discovered that the mice who received the fecal transplant had notable changes in the hippocampus of their brains, leading scientists to make the link between gut health (a healthy microbiome of the intestinal tract) and the effects of aging.
THE NATIONAL CYBER SECURITY CENTRE IN THE U.K. (NCSC) RECOMMENDS USING THREE RANDOM WORDS FOR YOUR PASSWORDS, rather than the complicated mix of alphanumeric characters that most sites STILL recommend. I had to update a password on a site just the other day, and it had to have a mix of upper and lowercase letters, numbers, and a special character. One of the NCSC's most popular web pages, even five years after its initial publication, explains how choosing three random words can help users pick passwords that are easier to remember than the popular mixed passwords. It's those passwords that use the eclectic mix of alphanumeric characters that force users to pick weak passwords (like "pa55w0rd!"). The NCSC asserts that three random words are random enough to thwart the vast majority of hackers. Of course, as we've covered here in the pages of The PCLinuxOS Magazine many times before, the longer the password, the more secure it is. But, to be successful, the three words should be truly random, and not related to the other words in the passphrase. For example, the passphrase "horsecartontrapeze" (three random words off the top of my head, without spaces) would take 23 million years for a computer to crack, according to the "How Secure Is My Password" website. This is despite the lack of numbers, special characters, and using all lowercase letters. That sounds more than good enough to me! The length of reported time to crack the passphrase goes up exponentially as the length of the passphrase increases.
RUSSIA HAS OFFERED TO HELP BOEING FIX THEIR STARLINER SPACE CAPSULE, according to an article on the Autoevolution website. In 2019, Boeing tested their Starliner capsule, but it failed to reach its intended target in orbit due to a software glitch. Then, after more than a year of trying to fix the issue, the next launch of the Starliner capsule never got off of the launchpad, when computers detected another problem, postponing the launch. Moreover, it's the way that the Russians voiced their offer to help, exposing that they are "well aware" of American engine building and all of their "developments."
NETFLIX'S CAMPAIGN AGAINST USERS USING A VPN TO CONNECT TO THEIR SERVICES is also "ensnaring" regular, non-VPN using" customers in their castnet, according to an article on the How-To Geek website. While there are some VPN users who use a VPN to circumvent the geolocking of content, there are way more users who use a VPN to enhance their security and to help prevent unnecessary data collection on their online habits. So how do you know if Netflix is blocking your IP address, thinking you are using a VPN? Almost all of the content, except Netflix originals and a few miscellaneous bits of content have gone missing. If you find your IP address is being blocked by Netflix, you can contact Netflix customer service. Some users caught in this broad Netflix castnet have reported that asking for their ISP to assign them a new IP address has also resolved the issue.
Surveillance Valley: Book Review
by Agent Smith (Alessandro Ebersol)

I have been writing for some time now about the shadowy relations of technology companies with the US government's espionage and military agencies. But ... what if things were worse than we think? What if all the history we have, that we hear about, that we accept as the history of the World Wide Web was just a fairy tale? A "cute" facade for a much more terrifying truth? That is the premise of the book "Surveillance Valley", by author Yasha Levine.
A fairy tale ? Or a horror story ?
I started reading Yasha Levine's book, and right from the introduction, it's a punch in the gut: Levine takes us to a meeting, which he attended, in 2014, at Oakland City Hall.
In his words, "Several hundred people packed the Oakland city council chamber. Many of them carried placards. It was an angry crowd, and police officers flanked the sides of the room, ready to push everyone out if things got out of hand."
Levine continues: "The commotion was tied to the evening's main agenda item: the city council was scheduled to vote on an ambitious $11 million project to create a citywide police surveillance center. Its official name was the "Domain Awareness Center" - but everyone called it "the DAC." The project specifications called for linking real-time video footage from thousands of cameras across the city and would concentrate them all in a unified control center. The police would be able to punch in a location and watch it in real time. They would be able to link facial recognition and vehicle tracking systems, link social media feeds, and enhance their vision with data coming from other law enforcement agencies - both local and federal."
Plans for this surveillance center had been brewing for months, and the scandal was now making its presence felt. Residents, religious leaders, labor activists, retired politicians, masked anarchists from the "black bloc" and representatives of the American Civil Liberties Union - all were present, rubbing shoulder to shoulder with a group of dedicated local activists who had banded together to stop the DAC. A nervous, good-natured city official in a tan suit took the podium to assure the boisterous crowd that the Domain Awareness Center was designed to protect them - not spy on them. "This is not a fusion center. We have no agreements with the NSA or the CIA or the FBI to access our databases," he said.

Oakland City Hall
The hall exploded in pandemonium. The crowd couldn't believe it. People booed and hissed. "This is all to monitor the protesters," someone shouted from the balcony. A young man, his face obscured by a mask, stalked to the front of the room and menacingly jammed his smartphone into the city official's face and took pictures. "How does it feel? How does it feel to be watched all the time?" he shouted. A middle-aged man wearing glasses and crumpled khakis stepped up to the podium and ripped into the city's political leaders. "Do you council members somehow believe that the Oakland Police Department, which has an unparalleled history of violating the civil rights of Oaklanders and which cannot even follow its own policies, be it a crowd control policy or a body camera policy, can somehow be trusted to use the DAC?" He went out with a bang, shouting, "The only good DAC is a dead DAC!" Wild applause erupted.
The people gathered at City Hall that night saw Oakland's DAC as an extension of the technological gentrification that was pushing the poorest long-time residents out of the city. "We are not stupid. We know that the goal is to monitor Muslims, black and brown communities and protesters," said a young woman with a headscarf. "This center comes at a time when you are trying to turn Oakland into a playground and bedroom community for San Francisco professionals. These efforts require you to make Oakland quieter, whiter, less scary, and richer - and that means getting rid of the Muslims, the black and brown people, and the protesters. You know this and so do the contractors. We hear them in meetings."
"They are scared. They admit it verbally." And, the fears were not unfounded. A few months earlier, a pair of investigative journalists in Oakland had obtained a series of internal city planning documents dealing with the DAC, they found that city officials seemed to be more interested in using the proposed surveillance center to monitor political protests and union activity on the Oakland docks than in fighting crime.
But, according to Levine, the DAC surveillance center had another partner. A partner that didn't appear directly. A silent partner. Who could it be?
Levine continues: "Thanks to a tip from a local activist, I had learned that Oakland had been in talks with Google about demo products in what appeared to be an attempt by the company to get a share of the contract with DAC."
But how? Google getting involved in facial recognition and cyber surveillance of citizens, often innocent and warrantless? Yes, and Don't Be Evil is long gone, eons ago.
And so begins the book, which already in its introduction, tells us about Google's involvement in more surveillance, something we are already used to. It is no longer surprising. But when the book came out, at the time of the Cambridge Analytica scandal, it was fresh material.
The Internet, in the words of Yasha Levine
"Everything we've been sold about the democratic nature of the Internet has always been a marketing pitch." Yasha Levine, on the military origins of the Internet, on data modeling and technocratic government, and why the Cambridge Analytica scandal was good for Facebook.
In his book, Yasha Levine raises the military and governmental nature of the Internet, with an interesting hypothesis, that the Internet exists primarily as a tool for surveillance and control of the masses. That's right, everything you have always heard about how the Internet was born as a means of human expression and growth, is not the whole truth.
And, Mr. Levine raises all the data to back up his claims. And, he does some historical research on how technology companies helped the military, from the Vietnam war, to IBM's shady dealings with Adolf Hitler's government in World War II.

How the book is made up
The book is divided into two parts: the lost history of the Internet, which deals with the roots of the Arpanet, which would, years later, become the Internet we have today.

In his research, Levine goes all the way back to the Vietnam War, making a very interesting parallel about how technologies used against the Vietnamese were also used against North American citizens.
The first part then focuses on the government's shift to technological solutions dealing with the Vietnam war and counterinsurgency. Sure, there was a lot of applied technology developed (Agent Orange, sensors to be spread throughout jungles), but also entire counterinsurgency systems that were focused on accumulating data on potential enemies (which could be anyone). So when the end of the Vietnam war was in sight, these same techniques were being applied to American civil society, plagued by political unrest due to the civil rights struggle, struggles with communism and so on.
The Second Part...
He then spends a lot of time focusing on the 1980s and the rise of the various utopian visions of technology. Here the author's political views become a bit of a distraction: characters are introduced and dismissed as libertarian, or as coming from what is clearly the "wrong background." The Electronic Frontier Foundation, in a sense the ACLU of technology-centric issues, is dismissed somewhat as the product of a "couple of millionaires" who attended a forum. One can only imagine how the author would reflect on any of the other institutions in the book that he *doesn't* describe how they were formed.
Finally, he spends time on the Snowden and NSA revelations, along with the Tor project.
The Tor Project
Here, the author creates one of the wildest theories I have ever heard. But because it is so incredible, it may be true.
It turns out that TOR is a service designed and built by the CIA, and even though TOR is now a non-profit organization, it is almost entirely funded by annual "donations" from a handful of US government agencies, most of them connected - to the CIA. The NSA sees the TOR as a giant "honeypot" where all the types of people they are looking for (drug dealers, jihadists, terrorists) gather in one place. They can be tracked and found with little effort. So while the government bemoans the criminals hiding in plain sight on TOR, it also encourages the use of TOR with taxpayer money.

How could this be possible? It seems that CIA agents using TOR to hide their online identities were immediately recognized as CIA agents because their activity showed that they came from TOR, so they must be spies. Therefore, the user base had to be expanded in order to hide the spies - in plain sight.
Yasha Levine obtained a box full of documents from the Broadcasting Board of Governors, another branch of the CIA, using the Freedom of Information Act. Everything is spelled out clearly and bluntly, including CIA updates on technical progress at the supposedly independent non-profit. Levine says that TOR employees are essentially federal civil servants. This book is a warning that you never know who your friends are, and that everything can be turned into a weapon.
Final Words
Reading this book is an interesting exercise in thinking outside the box. Not that reality is as bleak as Levine paints it, but that big tech's, along with tyrannical governments, whether in the West or the East, since much of the surveillance done by these corporations is already used by so-called "democratic" governments (the arrest of Julian Assange in England, the actions against Chelsea Manning, and the persecution of Edward Snowden are just a few cases, about individuals who denounced human rights abuses, perpetrated by governments, through big tech's, and, suffered bitterly afterwards. No, not Saudi Arabia, nor North Korea, but the democratic countries of the United States of America and England).

Book: "Surveillance Valley -- The Secret Military History of The Internet"
Author: Yasha Levine
Site: https://surveillancevalley.com
Barnes & Noble:
https://www.barnesandnoble.com/w/surveillance-valley-yasha-levine/1126997162?ean=9781610398022
Bookshop.org:
https://bookshop.org/books/surveillance-valley-the-secret-military-history-of-the-internet-9781610398022/9781610398022
Please don't buy from Amazon. Let's not give any more fuel to one of the most dishonest internet com


PCLinuxOS Recipe Corner:
Caribbean Style Curried Pork
Recipe provided by bb64
Serves 3-4
Unit converter
INGREDIENTS:
1/4 tsp Cinnamon
1/4 tsp Cumin
2 heaped tsp shredded dry ginger
1 tsp Garam Marsala** (in the spice section of your grocery store)
1 rounded tsp generic Curry powder
1/4 tsp ground nutmeg
1/2 to 1 medium habanero chile (finely chopped)
3-6 garlic cloves (finely chopped)
1 large onion
1-2 inches of lemon grass stalk (finely chopped)
1 SMALL tin/can of pineapple pieces
1 tin/can (400ml) (13.5oz) coconut cream.
500gm (1.1 lb) pork fillet (more sliced than chopped)
1/50th tsp fish sauce (or to taste)
1 tsp brown sugar (to taste, see step 7)
TO SERVE:
2 cups (dry) rice (your choice, I prefer jasmine)
1/2 cup sultanas or mixed fruit
1/2 tsp or less turmeric powder (or if you are rich and famous, a few saffron threads)
DIRECTIONS:
1. Prepare all ingredients - slice pork, drain pineapple, chop the onion, chile, lemon grass, garlic etc, separately combine all the dry ingredients.
2. Quickly fry the pork and set aside. *Don't over cook, it will finish off later in the sauce.
3. Boil water and start the rice cooking, add the turmeric.
4. Fry up the pineapple and set it aside with the pork.
5. Soften the chopped onions in the same pan and add the green ingredients and fry up once.
6. Add the mixed dry ingredients and stir fry.
7. Add half the coconut cream and boil up once. Then add the rest of the coconut cream. Add fish sauce and enough brown sugar to make the sauce just sweet enough for the audience, then simmer until it is thickish.
8. Add sultanas/mixed fruit to the cooked rice to suit tastes.
9. Turn off the heat and add the pork and pineapple. Leave it on the cooling stove-top but watch it's not overcooking the pork.
10. Serve as desired, singly or in a serving dish. Garnish as desired.
NOTES:
* Adjust to desired "heat" level by varying the amount or variety of chile.
* Adjust the sweet/sour/salt balance by judiciously varying the fish sauce.
* NOT suitable for refrigeration.
* CAN be somewhat prepared beforehand but loses some of the spices fragrance etc.
* My brother-in-law insists that this is greatly improved by adding 1 cup of dark rum towards the end of step 7 (that's 1/2 cup into the sauce and 1/2 cup into him).
** can substitute Garam Marsala with Chinese Five Spice
NUTRITION:
Calories: 248 Carbs: 29.6g Sodium: 428.7mg
Get The Weather Forecast From The Command Line
by Paul Arnote (parnote)
One thing I LOVE about Linux is that there are so many ways to do things.
When I used to run a KDE/Plasma desktop, one of my "must-have" widgets was one that displayed the weather forecast on my desktop. When I switched to the Xfce desktop, one of the first panel plugins I installed was the weather plugin for the Xfce panel. It's still that way today, anytime I install or reinstall Xfce.
I'm not obsessed with the weather, but I do like to know what's coming on my next day off, when I'm usually trying to plan something that I'll be doing with my wife and kids.
Well, there is a great way to get a weather forecast while you work in a terminal session, too. That means you don't have to leave your command line environment to check on the weather forecast.
I don't even remember how I stumbled across this, because it was in a post on the DietPi forum site, in the tutorial section. I don't even have a Raspberry Pi, so I don't tend to visit these types of forums.
Step One: Prep The Command To Make Things Easier
Enter the following command (all on one line):
echo -e "\nfunction weather()\n{\nif [ \$COLUMNS -lt 125 ]\nthen\n curl wttr.in/\$@?2n\nelse\n curl wttr.in/\$@\nfi\n}" >> ~/.bashrc && source ~/.bashrc
It will define the command as the function "weather" and place it in your hidden .bashrc file. Then, all you will have to do is enter "weather" at the command line to see the weather forecast for your location, as defined by your IP address.

You can safely ignore the "Warning" window that pops up when you attempt to paste the command into your terminal window. Just click on the "Paste" button, which on my computer, shows up at the upper right corner.
Press the "Enter" key at the end of the command after pasting it into your terminal window.
Step Two: Execute The Command
Now, just type "weather" at the command line prompt, and press the "Enter" key.

So, just entering "weather" on the command line, in my case, displays the weather forecast for Houston, TX. That is because my IP address points to Houston, since I'm connected to my VPN's Houston, TX server.
That's great and all, if I lived in Houston, TX. But, because I live in Independence, MO, I'm more interested in my local weather forecast than I am interested in the weather forecast for Texstar's backyard. (Sorry Tex!)
So, let's alter the command slightly so that it gives me the weather forecast for the location that means more to me making my plans. Fortunately, there are a couple of super simple ways to do this.
One way is to supply the city (and possibly state) of the location you want the weather forecast. If you live in a BIG city, you will most likely get away with just providing the name of the city. So, if you supply "weather Atlanta", you will get the weather forecast for Atlanta, GA. That works great, just so long as you live in a major city around the globe, or if you want the weather forecast for a major city you plan to visit. This works for Moscow, London, Paris, Rome, Berlin, etc. Notice how I capitalize the name of the city. If the name of the city has a space in it (e.g., New York, San Francisco, Kansas City), omit the space between the words (i.e., weather SanFrancisco).

If you live in a smaller city (I'm at my job in Richmond, MO as I write this, with a population of about 8,800), it's helpful to specify the state in the command. So, to see the weather forecast for Richmond, MO, I need to enter the command as "weather Richmond,MO" to get the correct Richmond. Otherwise, I get the weather forecast for Richmond, VA, which is quite some distance from me. Notice there is no space between the comma and the state designation in the command.
Now, maximize the terminal window, and then reissue your previously used "weather" command..

Notice how the weather forecast has expanded from just "Noon" and "Night," to now include "Morning," "Noon," "Evening," and "Night." So, just by maximizing your window (and reissuing the weather command), you obtain a much more detailed weather forecast.
Instead of specifying the city name (and possibly the state name), you can also specify the postal zip code for the area you are wanting to obtain a weather forecast for as a parameter for the "weather" command. So, the command "weather 64085" will also retrieve and display the weather forecast for Richmond, MO, just as if you had specified the command as "weather Richmond,MO". At least, it works that way for U.S. postal zip codes.
Summary
So, the next time you're working at the command line and want to know the weather, either for your area, or for some area you're thinking about visiting, you can retrieve the weather forecast for that area with a simple command.
See? There are many ways to achieve the same end result under Linux. I really love that versatility and flexibility.
Repo Review: Imagination Slideshow Maker
by CgBoy
Imagination is an easy to use tool designed for use in creating DVD slideshows. It provides a very simple and straightforward way for you to create slideshows of family photos, business presentations, or anything else that might require a slideshow.
The user interface is quite well laid out and has been designed for speed and ease of use. In the upper right corner of the screen, you'll find the play button and frame seeker buttons for previewing the slideshow. Down at the bottom of the screen is the timeline, from which you can select slides and then edit their properties on the sidebar to the right. To begin making a slideshow, simply click on the Import pictures button up in the toolbar to start loading your images into Imagination.

From the toolbar at the top, you can delete, flip, rotate, and zoom in or out on the currently selected slide. Imagination gives you a choice of 69 different transition effects, such as wipes and fades, which can be applied from a drop-down menu on the sidebar. You can also let Imagination choose random transition effects for you, if you wish. Both the transition speed and the slide duration time can be adjusted as well, and a time counter will show you how long the final slideshow will be.
Imagination also allows you to create motion effects on a slide, by adding a series of key frames, or Stop Points as they're called, and then adjusting the zoom level and panning the image for each point. This way, you can achieve Ken Burns style effects in your slide show.

You can also add text to the slides, which you can manually scale and locate on the image to your liking. Various animation effects can also be applied to the text, such as making it slide across the screen, or spin around as the slideshow plays.
Music can be added to your slideshow by clicking on the Import music button up in the toolbar (The icon appears to be missing for some reason, though, so the button looks blank). Going to the Audio tab on the side bar allows you to see the music tracks that you've loaded in, and you can delete and rearrange them from here. The tracks will play in order one after the other during the slide show, and will fade out during the last slide at the end of the video.

Clicking on the Slideshow menu up at the top, and then clicking Properties will open up a window where you can set the output video format, resolution, frame rate, aspect ratio, and video bitrate. The video format options include VOB (For DVDs), OGV, FLV, 3GP, and MP4. To export your slide show, simply open the Slideshow menu and click Export, then choose your output filename and location, and press OK.
Summary
Overall, I found Imagination to work very well during my usage, with only a few minor user interface bugs. If you want a simple and lightweight tool for easily creating slideshows of your photos, without needing to use a full-fledged video editor, then Imagination is a great choice.
GIMP Tutorial: Beginners Tips
by Meemaw
I'm always looking for new GIMP tutorials for you! Recently, I've been looking on the website called Davies Media Design to see what he's doing, and found a video tutorial he called "10 Things Beginners Need To Know". While I did a beginners article way back, GIMP has changed considerably since then, and it was interesting to see his ten things. Most of these things we should already know, but if we have beginners, I'll summarize his ten.
1. His first thing was to tell the beginners where to download GIMP: https://www.gimp.org/ but we already knew that. The thing we know that he may not know is that we can get GIMP from our own PCLinuxOS repository. He did emphasize that GIMP is open source and you should never have to pay for it.
2. The next thing, of course, is how to open an image. In most all programs, it's nearly always File > Open and lets you navigate to the correct file. Also, as we all know in many programs, there is more than one way to do everything. In GIMP, you can drag the image you're opening over the top of your toolbox and it will open as well. As you can see below, I've dragged an image to the top of the toolbox, and a black outline has appeared. When I let go of the mouse pointer, the image will open in GIMP.

In the newer versions of GIMP, you'll probably get a window asking if you want to convert some of your images to GIMP's native color profile. That's recommended.
3. The tools can now be grouped according to similarity. I believe that was a new feature in GIMP 2.10.18. The difference is below, showing ungrouped tools on the left and grouped on the right. Clicking on a tool in the grouped toolbox drops down a list of tools in that group for you to choose.

You can group or ungroup in the Preferences window, under Interface > Toolbox. Just click the box in front of Use tool groups. There's a configuration window as well, if you want to group them differently.

4. Another thing we already know - GIMP is highly customizable. You can change the theme (dark or light) and change the tool icon appearance. You can also change the icon size. In the Preferences where you change the icon appearance is a slide bar that lets you change the size of the icons. In the View screen, you can change the padding color (that's the background that your image is on). Clicking on View > Padding Color you can change it to dark, light, same as the window theme you're using, or choose a custom color.

5. In addition, you can rearrange the tools to suit yourself. You can open any tools you need or close tools you don't use. If you want the options all on the right side and ONLY the tool icons in a line down the left side of your window, you can do that. Here, I moved all the tools to the right and narrowed my toolbox. Tool options are at top right.

6. Going along with our last tip, you can close or detach any of these tools. Simply click on the little left arrow at the right of the tab, and choose Close Tab, Detach Tab (which makes it a separate window) or Lock Tab to Dock. Also present is the tab style which lets you see icon and text or icon only, and Show Button Bar, which hides the tools at the bottom of that particular tab. For example, if you are in Layers, unchecking the Show Button Bar box, your New Layer, Duplicate Layer, move layer up or down, etc, would be hidden.

7. GIMP uses a layer system. While I'm sure most of us know that, beginners will learn that the usefulness of layers is something you should get used to. You can create layers in the layers dialog tool. Having different parts of your creation on different layers makes them easier to manipulate. Putting text or another image on another layer can help you get your creation arranged just the way you want it.

In fact, when you make an animation, you have to put each of your changes on a new layer. Using a different layer allows you to move things just to where you want them, or if you've made a mistake, you can delete the layer it's on and start again.
8. The majority of the image adjustment tools can be found in the Colors menu. Yes, I know that there are dozens of filters, extensions and other tools. His point is that when you start working on an image, starting with one or two of the top 10 items in this menu will give you a great start on an awesome image.

9. If you want to add an effect to your image, those tools are in the Filters menu. You can create a mosaic from your image (Filters > Distorts > Mosaic), or even put a frame around it (Filters > Decor > Add Border) as shown below. The Filters menu has loads of possibilities. You'll just have to experiment.

10. Every time you work on an image, you need to save it occasionally, and when you are finished, you can export it to a different image format. If you are saving, GIMP will want to save in its native .xcf file format. This is good if you are happy with your work up until now, and need to close GIMP for some reason. The .xcf format will save all your layers, so you can start right in where you left off. When you are finished, you can still save, but you will also want to export your creation as an image in one of the image formats, such as .jpg or .png. Both are available from the File menu.

Bonus! As an additional beginner tip, I was talking to The Heat Exhausted CrankyZombie in PCLOS-Talk about posting photos in the forum, and noticed that many of them had his name in the bottom right corner. He said, "I just created a brush in GIMP and it's easy to add." So I researched a little on creating brushes in GIMP.
Create a new file with a width and length of 250px. In the advanced options, Color Space in Gray Level and Fill with white. Now, zoom in and add black text to it (or whatever color you want).
Save it in the directory /home/yourusername/.config/GIMP/2.10/brushes/ with a .gbr extension. Mine is named MeemawPic.gbr.
In the Brushes dialog window, click on Refresh brushes. Now it's there and ready to use. If you see that it's rotating when you try to use it, go to the Brushes Tool Options and change the Dynamics to Off.

I hope you'll go to Michael Davies' video and watch it as well. He has many other videos on his site and on YouTube. If you knew everything, that's great, but I have learned a few things.

Back In Time: Getting Started with Linux's Time Machine
by David Pardue (kalwisti)
Introduction
During the pandemic, I have become more conscientious about my backup regime on our two desktop PCs; I use the combination of Timeshift (for system files) and Grsync (for documents and personal files). I recently saw in the PCLinuxOS forum that Texstar recommended Back In Time [BiT] as a backup application for your personal files. After a bit of searching, I found that the Timeshift developers also rate BiT as an excellent tool.
Since I did not have a backup solution in place for our old -- but trusty -- Dell Latitude E4300 laptop (used as a secondary computer), I installed Back In Time to learn more about it. I hope that my article will help you get started with BiT and encourage you to explore its flexible yet powerful features.
Back In Time is a mature application, originally released in 2008; it is supported on all major Linux distributions. BiT was written by a team of developers including Dan Oprea, Bart de Koning, Richard Bailey, Taylor Raack and Germar Reitze.1 BiT was inspired by the now discontinued FlyBack project, which was a backup utility modeled loosely on macOS's Time Machine. BiT is based on the classic rsync CLI utility; it is written in Python and comes with a Qt5 GUI which will run on both KDE and GTK-based desktop environments.
The beauty of Back In Time is that although it is highly customizable (as we will discuss shortly), it is also suited for people who want a simple program for backing up their data. Configuration can be done entirely via the GUI; only three requirements for BiT must be specified: where to save snapshots; which folders to back up; and when to perform the backup.
A Two-Pronged Backup Solution
My simple backup strategy for this Dell laptop is to use Timeshift to take care of the operating system files (i.e., everything except for my /home folder), and Back In Time for my personal data (i.e., documents, pictures, music, videos).
You might be wondering ... "Why do I need two different backup applications? Can't I just use Timeshift for everything?"
If you use a single solution such as Timeshift, then when you need to restore your system (after a borked upgrade, for example), Timeshift will also overwrite your documents to a previous / earlier state -- something you definitely do not want. However, if you have separate backups for your OS and your personal files, you can just have Timeshift revert to a previous working state without affecting your current documents.
Install Back In Time
The first step is to install these two packages from the PCLinuxOS repositories:
The current stable release is ver. 1.2.1, which dates from 2019. Although it is possible to run BiT exclusively from the command line, I suspect that most users would be more comfortable with the GUI version.
Prepare a USB Flash Drive as Backup Storage Medium (Optional)
This laptop is primarily used for Web browsing and word processing, so it does not have a lot of data stored on it. I decided that a 16 GB USB flash drive should suffice for my backup medium, and that I would designate it exclusively for this machine.
The USB flash drive came formatted with the FAT32 file system by default. However, Back In Time recommends the use of a reliable, Linux-friendly file system such as ext4. With GParted, I wiped the flash drive by creating a gpt partition table and a single, large partition formatted as ext4
. If you would like some guidance, this brief article provides instructions:
"How to Format USB Drives and SD Cards on Linux." Linuxize 7 Jan. 2021.
I also used GParted to set a name for the USB backup partition ("Backup") following these steps:
https://gparted.org/display-doc.php%3Fname%3Dhelp-manual#gparted-name-partition

After plugging the flash drive into a USB port and mounting the drive, I ran the chown command from the Terminal, to set the user and group ownership to myself (username david). (I am the only user on this computer).
# chown david:david -R /media/770841ba(...)5ea03
As a final test, I tried copying a small text file from my /home folder to the USB flash drive; this operation was successful. Then I issued the $ ls -l command to check the file's owner and show read/write permissions. The output looked as expected:
[david@localhost ~]$ cd /media/770841ba-ae6e-4cbd-8b66-b3694ea5ea03
[david@localhost 770841ba-ae6e-4cbd-8b66-b3694ea5ea03]$ ls -l
drwx------ 2 david david 16384 Jul 13 13:22 lost+found/
-rw-rw-r-- 1 david david 1402 Jun 15 12:23 mesa-iris-test-dell-laptop.txt

Using Back In Time
Before starting BiT, plug in your external drive (whether USB flash drive, HD or SSD):

Launch BiT with a Shortcut
The program installs two shortcuts under the Archiving menu (in the PCLinuxOS LXQt Community Release): Back In Time and Back In Time (root). The root version runs with root permissions, which are required to access system folders and files (i.e., do a full backup of your OS). Since you will only be backing up your personal / standard files, choose the Back In Time shortcut:

First-Run Dialog
When Back In Time runs for the first time, a pop-up dialog appears, asking if you want to restore a previous configuration. Since we do not have a previous configuration, choose "No" to proceed:

Settings Dialog
The Settings dialog is the configuration section of BiT. It includes several tabs which we will navigate through: General; Include; Exclude; Auto-remove; Options; Expert Options. (Don't worry ... The process is not as intimidating as it appears, although it takes some time to carefully examine the available options). I will discuss each tab separately.
You will not have to repeat the configuration process after you have taken your first snapshot; all the information will be retained in your BiT Profile.

Profile

BiT allows you to create different profiles with separate backup settings. For example, the Main profile could back up internal data drives, which include specific data folders; the Second profile could back up an external hard drive.
Another possible scenario could involve the Main profile backing up your /home partition, while the Second profile could be set to back up a separate Data partition. (Your Main profile must be defined / completed before you can create additional profiles. To add another profile, click the Add button, supply a profile name in the New profile dialog, and choose your desired settings via the configuration GUI).
To keep things simple, I accepted the default setting: Main profile.
General Tab
Mode

The Local mode is for a local drive -- either internal drive (HD or SSD) or an external drive plugged into your PC.
I chose Local because my USB flash drive counts as a hot-pluggable external drive.
SSH and SSH encrypted are intended for Remote use, i.e., with a network drive or storage in the cloud. If you are interested in configuring BiT for backups via SSH, please consult Jack Wallen's brief article, "How to configure Back In Time to back up over SSH" TechRepublic 18 July 2019.
Where to Save Snapshots

Next, select the location where you want to save your backups.
Click on the folder icon and navigate to your backup drive. (If it is an external drive, you should have already inserted it). In my case, its location was /media/770841ba(...)5ea03 (labeled with its UUID):

Advanced
The Host, User and Profile fields will be auto-filled, so you do not need to change them:

Schedule
The Schedule section has a drop-down menu listing a variety of backup frequencies:

Note: If your backup drive / medium is not always attached to your PC, you cannot do scheduled snapshots. However, this is fine -- as long as you are reasonably disciplined about manual backups.
Include Tab
The Include tab allows you to select which folder(s) to back up. Click the Add folder button, then navigate to the desired folder(s).

I went to my /home/david folder, then clicked on the Choose button:

When you finish this step, your choice will display in the Settings window:

Since you decide which folders to back up, you can configure a custom backup solution that is more tailored to your needs.
Exclude Tab
This is pre-populated and the defaults are reasonable/fine. Nevertheless, you can add more folders, if you wish. You can exclude an entire folder, a single file or a group of files based on a regular expression.

A helpful option is that files larger than a user-specified size can be excluded. For example, I typically keep current .iso images of multiple PCLinuxOS versions (MATE, Xfce, LXQt, Trinity, KDE) in my Downloads folder; I prefer to exclude them from backups because they can easily be re-downloaded when / if I need them.

Auto-remove Tab
The Auto-remove feature offers fine-grained control of your snapshots. You can remove backups automatically, based on their age and the amount of free / available storage space.
The defaults are satisfactory for my needs, so I left them all unchanged:

Options Tab
This provides an opportunity for further customization, although the defaults are fine for most users. One option which laptop users might appreciate is: Disable snapshots when on battery:

Expert Options Tab
This tab has an ominous, boldfaced warning: Change these options only if you really know what you are doing! Therefore I did no tinkering and accepted all the default settings:

Congratulations! The main configuration of BiT is now done. The next step is to take an actual snapshot.
Take a Snapshot
Click OK in the Settings dialog (lower right corner) to finalize your configuration.
This will launch the main BiT window:

Click on the floppy disk icon to take a snapshot:

Note: The first backup will most likely take a while ... This is normal, so please wait patiently. Subsequent backups happen more quickly because they are incremental, i.e., BiT only saves files which have changed since the previous backup.
When the backup finishes, you will see two entries under the (left-hand) Snapshots column: one is labeled Now; the other is a time-stamped snapshot (i.e., the backup). Now is a live view of the local file system; it shows exactly the same files that you would see in your DE's file manager (Dolphin, Caja, Thunar, PCManFM-Qt, etc.):

The Timeline lists the backup snapshots which have been taken:

After its first run, BiT creates a backintime folder on your backup medium:

Restoring
Back In Time stores its backups in plain text. This enables the restoration of files without using BiT, if necessary. Backup snapshots are stored as files and folders, so you can browse them directly. If your backup is on an external HD, you can connect it to another Linux PC, and access your files without converting them or extracting anything.
File ownership, group and permissions are stored in a separate, compressed plain text file named fileinfo.bz2.

Back In Time can restore files either at the individual level, or at the folder / directory level.
Restore Individual File(s)
There is no substitute for seeing BiT's Restore feature in action, to fully appreciate it. I provide links to two video tutorials (with timestamps) in the "Additional Resources" section below; they include brief demonstrations of file restoration.
However, the general procedure works thusly: select the snapshot date; browse through the backup's folders; find the file you want to recover; select it; and click the Restore button.
As an example / test, I deleted a file from my current Documents folder: a recipe booklet named ADP_recipe_bk_full.pdf.
I know that file exists in my backup snapshot of 2021-07-17, so I highlighted / selected the snapshot in BiT's main window.
I navigated to my (backup) Documents folder and selected it.
Next, I found the recipe booklet's file and clicked to select it.
I right-clicked and chose the Restore option:

A pop-up dialog appeared, asking "Do you really want to restore this file?"
In most cases, the first option (which is the default) is the best choice.

Then I clicked Yes to proceed.
The Restore process ran while a pop-up window displayed log information. I clicked the Close button when the process finished.

Voilà! When I rechecked my current Documents folder, the file had been magically restored:

Exit Back In Time

Additional Resources
If you would like to read more about Back In Time, you can consult the program's documentation here:
https://backintime.readthedocs.io/en/latest/
Although the mechanics of using the application are not discussed, many of the configuration options are explained in detail.
The most recent, thorough and beginner-friendly video tutorials I found on YouTube were created by EF-Linux (Ermanno Ferrari) and Optimal Cadence (Kirt):
https://www.youtube.com/watch?v=Mnfz6gBFhi8
EF - Linux Made Simple. "Arch Linux post-install: Backup and restore your personal files with Back In Time." 1 Apr. 2020. (7 min., 26 sec.)
The presenter actually starts working with Back In Time at 2:25. Although he is running Arch Linux, BiT's functionality is identical regardless of the distribution.
An example of BiT's Restore feature is demonstrated from 5:38 until 6:05 of the video.
>https://www.youtube.com/watch?v=nbly4RS_EZc
Optimal Cadence. "Back up and restore Elementary OS and other Ubuntu distros using Timeshift and Back In Time." 15 Feb. 2020. (31 min., 39 sec.)
The host begins discussing Back In Time at 5:02 and continues until 14:45. He shows how to perform a BiT Restore in user mode from 22:04 until 24:03.
In conclusion, Back In Time is a great tool for helping you establish a backup routine. According to World Backup Day's website2 and other online sources, losing your files is more common than you might think. Considering that 60 million computers will fail this year, and 30% of people have never backed up, it's not a question of "if" you're going to lose your data, but "when." A word to the wise is enough -- Happy Backing Up with BiT!
1 Germar Reitze, now the primary developer of BiT, is also an architect. He designed the "Zyklus" ('Cycle') water feature for the courtyard of the German Children's Hospice Association (Deutscher Kinderhospizverein) in Olpe, Germany. The water's course can be changed using sliders, thus symbolizing that life -- like water -- sometimes takes a different path yet still continues to flow. Some photos of the fountain can be seen at: https://www.deutsche-kinderhospizstiftung.de/ueber-uns/historie
2 World Backup Day highlights the importance of data protection through backups. The geeky holiday is celebrated each year on March 31st. The original idea -- from a couple of concerned Reddit users in 2011 -- was a humorous reference to April Fool's Day. (If you don't want data loss to make you look like an April fool, you need to create regular backups [by March 31]).
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KDE's Telemetry: The Tip Of The Iceberg?
An editorial by The Cat

(photo by Uwe Kils, with modifications)
Recently, there was a debate on the PCLinuxOS forum about KDE Plasma's implementation of telemetry through KUserFeedback. While in PCLinuxOS, we can remove it without any collateral effects to the system, while other users reported that doing the same in other distros (like Debian 11) results in the complete removal of KDE Plasma! Why force such an implementation, if, as KDE's developers say, it is just an innocuous, privacy-respecting measure?
Coincidence or not, in the past years many popular Linux distributions started rolling out optional telemetry. Then it was the time of computer programs: news broke out in May regarding Audacity, a popular audio editing app, which announced it was starting the use of telemetry. The move was finally pushed back after users revolted against it.
But in Plasma's case, it is not just an app or a single distro, but an entire desktop environment, employed in several Linux distributions, that is being shipped with telemetry. While many point out that the data collection is by opt-in and entirely anonymous, others have found that, even if you don't activate telemetry, data is still collected, using computer resources, registering "apps and boot, number of times used and duration in /home/user/telemetry folder." As such, they argue that, because of the way Linux permissions work, other programs could have access to these log files. KUserFeedback's FAQs page confirms this:
"KUserFeedback is designed to be compliant with KDE Telemetry Policy, which forbids the usage of unique identification. If you are using KUserFeedback outside of the scope of that policy, it's of course possible to add a custom data source generating and transmitting a unique id."
Not being an expert on such matters, it is anyway a little strange the step taken by KDE and the way it is being implemented by most mainstream distros, as if there was a certain consternation about it. To better understand the picture, let us give a look at the organization that maintains the Plasma desktop.
KDE: What Is It?
Most people know KDE because of its Plasma desktop environment, its applications and its community. Few have ever observed that, at the bottom of their website, there is the indication of an organization called KDE e.V. If you click on it, you will find out that the desktop and the apps are all property of this non-profit organization based in Germany. So far so good. It is always nice to have a legal framework to protect software development. But, as in any organization, you need money to run it. For it, you need supporting members: little ones, which, in KDE's case, must donate at least one hundred euros, and the corporate ones. Large corporations must pay a yearly fee of ten thousand euros (roughly US $11,700), and are then called "patrons". Among KDE's patrons are Google, Canonical, SUSE and Qt. Now things start to become clearer! Here is Google again on the scene, with Canonical and SUSE! And the last two have also implemented telemetry on their systems! What a coincidence!
But this is not all. Because, when you have money, gates are fully open to you! When you are a patron, you automatically join KDE's advisory board. Among board members, we have: Debian (funded by Google and HP Enterprise), Canonical, SUSE (both funded by AWS, Google, Huawei, Microsoft and IBM), Qt and the Open Source Initiative (which is also funded by Google and IBM). Oddly, Google disappears from the board, but it is always backstage. But now one can understand why you cannot remove KUserFeedback from Debian without removing Plasma. They are among the ones who decided it and are backed by Big G.
The Tip Of The Iceberg?
It is not from today that big corporations have started to take over the Linux ecosystem. Acquiring stakes in companies and donating to non-profit organizations, they have gained a highly privileged access to the decision-making level of many (if not most) structures related with Linux development. Now we are starting to see some of those fruits. For the moment, systemd and some optional telemetry. Perhaps tomorrow, systemd and telemetry by default with some hidden opt-out. And someday we risk seeing -- too late -- that most Linux distributions have converged to the same positions now held by Apple, Google, IBM and Microsoft, because they have become just another tentacle of them.


PCLinuxOS Bonus Recipe Corner:
Bacon, Ham & Cheddar Omelet Bake
Serves 4-6
Unit converter
INGREDIENTS:
1 tablespoon vegetable oil
1/2 cup chopped green bell pepper
1/2 cup chopped onion
12 eggs
1 cup milk
1/2 teaspoon salt
1/2 teaspoon pepper
1 1/2 cups shredded sharp Cheddar cheese (6 oz)
1 cup crumbled cooked bacon
1/2 cup diced cooked ham
DIRECTIONS:
1 Heat oven to 350F. In a 12-inch ovenproof skillet, heat oil over medium-high heat. Cook bell pepper and onion in oil 3 to 5 minutes, stirring frequently, until tender.
2 In a large bowl, beat eggs and milk with whisk; stir in salt, pepper and 1 cup of the cheese. Add bacon and ham to pepper and onion mixture in skillet, spreading evenly over bottom of skillet. Pour egg mixture into skillet; top with remaining 1/2 cup cheese.
3 Bake for 32 to 37 minutes or until just set and a knife inserted near the center comes out clean. Let stand for 10 minutes before serving.
TIPS:
Top with optional green onion and tomato.
Assemble, cover and refrigerate this bake the night before so it's ready to uncover and pop in the oven in the morning. You may need to add an additional 5 to 10 minutes to bake time.
NUTRITION:
Calories: 300 Carbs: 4g Fiber: 0g Sodium: 690mg
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